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1. Introduction

WordHider is a Macintosh program to create and print “Word Search” puzzles, using vocabulary 
you provide.  It is intended for people who might find Word Search puzzles a useful tool 
(teachers, etc.), not for “word search enthusiasts”;  so it does not have any ability to generate 
puzzles from a built-in vocabulary for you to solve, nor does it solve puzzles itself.

1.1. Quick Requirements

1.1.1. Systems Requirements

You need a Macintosh computer, or a clone of a Mac, with at least a 68030 processor.  (i.e. it will
work on any Mac from the Classic-2, Mac-2, or LC series on.  That includes all current Macs, 
PERFORMAs, etc.  Separate binaries are available for 68K Macs and Power Macs.  The 
program runs on System 7 and on.  It has not been tested on System 6, but will probably work.  
You need about 3 Meg of Disk space to store the program and associated files, and at least 2 Meg
of available RAM to run it.

1.1.2. Legalese

This program and its documentation are placed in limited public domain.  I give any individual, 
or any educational institution or employee thereof permission to copy it and use it freely.  It may 
not be sold for profit, but modest storage and shipping fees may be charged by freeware 
collection distributors.  It may not be modified without permission, and probably wouldn’t work 
anyway.  The author retains the copyright and other property rights, but accepts no liability for 
the program’s use, and makes no warranty.

This program is not “shareware” and you are not expected to send any money, nor is there a 
registration function.  However, if you send me an email, I’ll do my best to keep you informed of
any updates.

The program was written using the excellent “Prograph CPX” development environment, by 
Pictorius Software.  Portions of the run-time system are © Pictorius.  See their web page at 
http://www.pictorius.com to learn about this highly productive development system.

1.2. Tutorial

In this section, you will walk through the construction of the following simple word-search 
puzzle.  First, let’s define some terms and show how the end user (e.g. your student) would solve 
this puzzle.
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1.2.1. Terms

Puzzle 
Grid

Word List

Answer Area

The actual puzzle is a grid, or matrix, of letters, organized into rows and columns.  An individual 
letter, in one of the individual squares of the grid, is called a cell.  Your puzzle can have any 
number of cells, containing any number of words.

Most of the puzzle grid is filled with words, hidden in different directions.  Since there are not 
usually precisely enough letters to fill the grid, there will also be a small number of fill 
characters, that are not part of any word.  These can either be random, or can comprise a hidden 
message.  In the example above, the fill letters are a hidden message.

Somewhere on the page you will also print a word list, which gives your user the list of words 
they are trying to find.  

Finally, if the fill characters are a hidden message, you may want to provide an answer area 
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where the user can copy the letters to read the message.  In the above example, we’re providing 
room for the user to copy 6 letters that will form two three-letter words.
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1.2.2. Solving the Puzzle

Before we create the puzzle, let’s watch how your end user would solve it.  They will pick the 
first word from the word list, cross it out in the list, and cross out or circle the word in the puzzle:
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They will continue this until all the words have been found:

Note that, in this simple example, all the words read horizontally, left-to-right.  In a complex 
puzzle, they might also read vertically or diagonally;  and they can go backward as well as 
forward.  This is all under your control when you build the puzzle.
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Note that some letters were left over.  The user will now copy these letters to the answer area, 
and read the hidden message:

I T S F U N

In this simple example, the hidden message was in order.  For a harder puzzle, you can use an 
anagram - the letters of the hidden message can be in random order.

Look at the above example again.  Note that the word “SUN” appears vertically near the left side
of the puzzle.  This is a coincidence - just an accidental alignment of characters on the grid, and 
not one of the words you put into the puzzle.  So, what if a similar accidental alignment of 
characters created one of your words somewhere in the puzzle?  The user might find the wrong 
copy of the word, and this would destroy the ability to find the other words, and destroy the 
hidden message.  Such accidental creation of one of your search words is called a “pseudoword 
conflict” and is not allowed.  The program ensures it never happens.
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1.2.3. Creation of the Simple Puzzle

1.2.3.1. Start the Program

Locate the “Word Hider” program.  It has an icon like this: .  Run it by double-clicking, in 

the usual way.  

If it completely blows up, you may have the wrong version for your machine (i.e. a Power
Mac version on a pre-Power Mac machine, or any version on an ancient Mac Classic or 
Mac Plus);  or you may not have enough memory.  See section “Troubleshooting” for 
hints.
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If all is well, the program will start and you will see a menu and two windows, one partially 
covered by the other:
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Normally, you would immediately start entering words into this window.  

BUT NOT NOW.

We want to guarantee that you get exactly the same results as in the example puzzle above, and 
that requires an extra step, entering “Tutorial Mode”.

1.2.3.2. Enter “Tutorial Mode”

This is a step you need to do only because you want to reproduce exactly the results in the 
example above.  Because the program makes certain random decisions, you could not normally 
be sure that running it would produce exactly the results above;  we are going to temporarily turn
off the randomness, just for the purposes of this tutorial.

You must first close the windows that were just opened for you.  In the File menu, select the 
Close command, like this:
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The windows will close.  The program is still running, however.  Now, from the Puzzle menu, 
select the Tutorial Mode item, like this:

1.0 February, 1996 ©1996 Page 14



1.0 February, 1996 ©1996 Page 15
You’ll get an explanatory window.  Click the Proceed button, and do the same in the warning 
that results, like this:
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That’s it - you are now in “tutorial mode”.  All that means is that, if you follow the steps below, 
you will get the puzzle above.  It has no other effect, and the effect lasts only until you quit from 
the program.  Repeat the above steps any time you want to work through this tutorial section, 
other wise forget them.
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Now, get the program to open up those original windows again, by selecting New from the File 
menu, like this:

You will now see the same original windows that appeared when you started the program.
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1.2.3.3. Enter the Puzzle Words

The Main Word List window is where you enter the words you want in the puzzle.  Click once 
in the text entry box to the right of the Add Word button, and type the word “word”.

Now click on the Add Word button.  The word will move to the list at the top of the window, 
like this:
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Note that the blink text-insertion point is still in the text entry square.  So, you don’t have to click
in that area again.  Just type the next word: “find”.  This time, try hitting the return key instead
of clicking on Add Word.  This works the same way, and you now have the following:
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One at a time, put the remaining words: good, tool, and yes in the list.  You should end up 
with a window like this:  To make this tutorial work, be sure you enter the words in exactly the 
order described here.
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It’s important that you have the above setup before proceeding.  If it’s not exactly as above, start 
over by selecting Close from the File menu, followed by selecting New from the File menu.  
When you have the word list shown above, proceed to the next step.
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1.2.3.4. Define the Page Layout

Now we’ll start to define how the printed page should look.  You need to bring the other window
to the front.  You could click on it (it is sticking out to the right of the Main Word List) 
window, or you can select Layout Window from the Puzzle menu like this:

The other window will come to the front, and you will see something like this (not shown actual 
size here):
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On the large white space in this window, you draw a representation of how you would like the 
printed puzzle page to look.  There are scroll bars to let you see the whole printed page, which is 
larger than the window.  (Later, we’ll also explore the ability to reduce the size of the view so 
you can see the whole page on the screen.)

For now, we’ll show where we’d like the “puzzle grid”.  Click once on the Puzzle Area box on
the left:
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Let go of the mouse button and move the cursor back into the large white area (which we’ll start 
calling the Layout Area).  Notice that the cursor changes from an arrow to a cross-hair:

Now, click and hold the mouse button.  While holding it down, move the cursor and trace out a 
rectangle about 3 inches on a side, like this:

Release the mouse button.  After a moment, a grid will appear like this:
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The program has automatically determined that a 5-by-5 puzzle grid would be a good size for the
words you have entered.  Later, you’ll see that you can manually set the size if you want to.
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1.2.3.5. Place the Words in the Puzzle

From the Puzzle menu, select the AutoPlace Words item, like this:
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The program will now use a simple method to fit the words into the puzzle grid.  This will take a 
few moments, and the program will tell you what word it is working on.  Once it is done, you 
will see this:

If all the words aren’t placed in the puzzle, or if they are not in the above locations, you either 
didn’t get into “Tutorial Mode”, as described above, properly, or added some other steps.  You 
can try again but it’s not that important - why not just note the differences and go on.

1.2.3.6. Layout the Word List

Now we’ll have the list of words to be found placed on the page.  First, let’s make the puzzle grid
smaller, to make some room on the window.  (We could, instead, make the window larger, but I 
don’t know what size of screen you’re using.)  If you drew your grid area small enough to leave 
room for the other items in the first place, you can skip this step.

Notice that the terminal has changed back to an arrow.  Click once anywhere inside the puzzle 
grid, and release.  A border will appear, like this:
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Handle
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The tiny black dot in the lower left corner of the grid is called a handle.  Carefully click and hold
on the handle.  While holding the mouse button, drag up and to the left a bit, tracing out a smaller
rectangle like this:

When you release the button, the grid will be redrawn smaller.  Now select the Word List box 
to the left by clicking once on it:
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Now, click-hold-drag with the mouse to trace out a rectangle about an inch high and three wide, 
below the puzzle grid, like this:
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After you release the mouse button, the word list will be drawn in the rectangle you have traced, 
like this:
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1.2.3.7. Fill In the Hidden Message

Now we’ll tell the program what hidden message to put in the remaining cells.  Select 
Specified Fill from the Puzzle menu:
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The following window will appear:

If you get a different window, you probably selected the wrong menu item, most likely 
Random Fill.  Close the window by clicking Cancel and try again, being careful to 
select Specified Fill.

1.0 February, 1996 ©1996 Page 35



1.0 February, 1996 ©1996 Page 36

Type the hidden message “its fun”, including the space.  Leave the other options on this 
window alone.  

Click Ok.  You’ll go back to the previous window, and the characters “itsfun” will be placed in 
the puzzle.  The blank is not placed in the puzzle.  This is what you’ll see:
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1.2.3.8. Layout the Answer Area

Now we’ll draw the boxed area where the user can fill in the hidden message letters.   We’ll put 
this area below the word list.  First, we scroll the layout widow up a bit to reveal some more of 
the space below the word list.

Use the right-hand scroll bar to scroll the window down a bit.  There are many ways to do this, 
and it is a common Mac operation.  If you don’t know how to do it, try clicking once, quickly, on
the down-pointing arrow at the bottom of the vertical scroll bar, in the lower-right corner of the 
window.
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You want to end up with the window scrolled a bit, revealing some of the white space below the 
word list, approximately like this:
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Now select the “Answer Area” item, and draw a long narrow rectangle by click-and-drag 
below the word list:
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After you release the button, you’ll get a rectangle like this:

The program has automatically put boxes in the answer area in which your user can print the 
answer characters, and it has generated a shaded box corresponding to the blank in your answer 
text.  You’ll learn how to alter this behaviour later.

1.2.3.9. Print the Puzzle

Like any other Mac program, you can now use Page Setup from the File menu, followed by 
Print from the file menu to print the puzzle you have made.  Compare it to the example above, 
and try solving it before moving on.

1.2.3.10. Save the File

To save a file containing this or any puzzle you define, select Save or Save As… from the 
File menu.
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1.3. Terms & Concepts

A few terms are used constantly by the program and this document.  Also, certain actions 
generally have a consistent meaning.  
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Directions Words in the puzzle grid can be placed in any direction you allow.  
Normally, only the directions in which English is commonly read are 
enabled:  left-to-right, top-to-bottom, and the two left-to-right diagonals.

To make an easier puzzle, you can enable, for example, only left-to-right 
and top-to-bottom.  To make a harder puzzle, you could enable the reverse 
directions.  You’ll see how to enable the various directions later.

Fill Fill is the general term for the characters that fill in all the remaining 
puzzle cells after all the words are placed.  It can be either random 
characters or the characters from a specified phrase.

Place / Unplace The verb place refers to putting words from the word list into the puzzle 
cells.  Words already in the puzzle can be removed from the puzzle, 
without being deleted from the word list - this is called unplacing them.

Double-click Double-clicking on any object drawn on the layout area (e.g. the puzzle 
grid) will open a window allowing you to modify various options for that 
object (e.g. whether a border is drawn around it).

Option-click Option-clicking (clicking the mouse button while holding down the 
keyboard’s Option key) on a cell in the puzzle grid has a special effect, 
used for manually adjusting word placement.  Details will follow later.

1.4. “Pseudoword Conflicts”

You’ll recall from the example above that there is a possibility of accidentally creating a word in 
the puzzle through the coincidental alignment of characters.  As another example, supposed the 
words “THE”, “OLD”, and “PAN” are arranged in 3 horizontal rows, as follows:

T H E

O L D

P I E
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Note that the word “TOP” is also created, vertically in the first column.  If TOP was also one of 
your puzzle words, and was placed elsewhere in the puzzle, your user could pick the wrong one.
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As a simpler example, suppose you have the two words “THE” and “ALTOGETHER” in your 
word list.  This is a guaranteed problem, since wherever these words are placed in the puzzle, the
user might pick the characters THE that appear inside the word ALTOGETHER instead of the 
separate word THE elsewhere in the puzzle.  After doing so, they would be unable to solve the 
complete puzzle.

The program uses the following techniques to ensure that you never have this kind of conflict.  
They are mentioned here because you may occasionally find you are prevented from doing 
something you might want to do because of one of these rules.

1. In the tests involving these rules, all directions in the puzzle are always used, not just the 
ones you have enabled.  That’s because you can change the directions allowed at any time, 
and if the rules weren’t enforced consistently, you might create an invalid puzzle after it 
was too late to correct it.

2. When you are entering words to the word list, no word will be accepted if it is a subset of 
another word already in the list or vise versa.  So, in the example above, you would be 
prevented from having both “THE” and “ALTOGETHER” in the word list.

3. Rule (2) is also tested with each word in reverse order.

4. When placing a word in the puzzle grid, every letter is checked against every neighbouring 
letter, and tested to make sure that no word in the word list is created through this 
coincidental alignment.  

a. During automatic placement, no word will be placed into such a conflict;

b. When you are manually placing words, such conflicting placements will be rejected if
you attempt them.

5. Fill characters are prevented from creating words in the word list through their coincidental
alignment with their neighbours.

a. When inserting Random fill, characters are chosen that do not create such conflicts;

b. When inserting Specified fill, the fill will be rejected if one of the characters creates 
such a conflict.
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2. Details of Operation

2.1. Entering Words

There are two methods you can use the enter words into your puzzle’s vocabulary.  A basic 
interface for manually entering words is available, and the program can also scan other files on 
your Mac and extract words meeting certain criteria.

2.1.1. Manual Entry

Basic manipulation of the word list is done in the Main Word List window:
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Auto Place

Unplace
Words successfully placed in the 
puzzle grid are listed here

Words in your puzzle's 
vocabulary, but not yet placed 
into the puzzle grid, are listed 
here.

Capacity Information

Entry Area

A number of operations can be performed in this window.

• You’ve already seen that you can add words to the vocabulary by typing them into the entry
area and then either pressing Return or clicking the Add Word button.  

• As you enter words, they are listed in the “not yet placed” list at the top of the window. 
As a short form, we’ll call this the “unplaced list” from now on.

• If you click on a word in the unplaced list it will be highlighted.  There are several 
operations that can then be performed:

- Holding down the Shift key, click another word to highlight all words between the 
previous and new ones.
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- Holding down the Command key (the ⌘ key), click another word to highlight it as 

well.

- Press the Delete key on your keyboard or select Clear from the Edit menu to 
delete the selected word(s) from the vocabulary list.
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- If it is enabled, click the Auto Place button to place the selected word(s) in the 
puzzle grid.  The Auto Place button will be disabled if you have not  yet defined the
puzzle grid in the Layout window.

- By dragging the mouse with the button held, you can move words around in the list.  
The order of words in the list has no impact on the program.

• As words are placed in the Puzzle Grid, they will also be moved to the “Words placed 
in puzzle” list in the middle of the window.  We’ll call this the “placed list” from now 
on.

• You can click, shift-click, or ⌘-click on words in the placed list, exactly as for the 
unplaced list.  You can then move them around, or click the Unplace button to remove 
them from the puzzle grid and return them to the unplaced list.  You cannot delete words 
from the puzzle vocabulary by selecting them in the placed list and pressing Delete - you 
must first Unplace them.

• As a shortcut, you can select all the words in either list by clicking once on the list, then 
selecting the Select All item from the Edit menu.  So, a fast way to place all the defined 
words into the puzzle grid would be to:

a. Click once on the unplaced list.

b. Select Select All from the Edit menu.

c. Click the Auto Place button.

• Note the capacity information in the bottom right corner of the window.  If the puzzle grid 
has been defined, this area will tell you how close you are to filling it.  However, you 
normally will not define the puzzle grid before entering the words;  instead, you enter the 
words and let the puzzle grid automatically calculate the best size for itself.

2.1.2. Scanning Text Files

If you are defining a puzzle as an exercise to accompany some teaching topic, you may find it 
convenient to extract the vocabulary from an existing word processing document.  For example, 
if you have a class notes page in a Microsoft Word document, the words in that page might be 
ideal puzzle vocabulary.  This program can scan such a document and extract words meeting 
certain criteria.

There are several points to be discussed in using this feature:
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- The program can’t read the internal file formats of the dozens of available commercial 

word processors.  However, commercial word processors can all produce “simple text” 
files this program can read.

- The word processing file will contain words you don’t want in your puzzle (e.g. very small 
words, technical acronyms, etc.), so you need to be able to eliminate these.
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- The word processing document might be very large, and you need to be able to scan only a 
subset of it.

2.1.2.1. Preparing the Word Processing File

Your first requirement is to make a copy of your word processing file as a plain text or text-only 
file.  Most word processors have the ability to do this, but how you do it varies from program to 
program, and I can’t describe all the options.  (I’ll show an example with Microsoft Word, since 
you must have it to be reading this document, below) You’ll need to consult with your word 
processor manual for other programs.

Also, a sample plain text file, called “sample scannable file”, is included with this document, so 
you can skip this step and use that file for now if you like.

To make a plain text file copy of a Microsoft Word (version 5) file, perform the following steps:

1. Select and open a Microsoft Word document you have lying around.

2. In the File menu, select Save As… like this:
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3. Important: give the file a new name by typing into the appropriate area on the next 
window, like this:

If you don’t give the document a new name, you’ll destroy the “real” Microsoft Word copy 
of the document.
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4. Click on the pop-up menu, as shown below, and select Text Only:

5. Make sure that the window looks like the following (especially that Save File as Type 
reads “Text Only”), then click Save:
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2.1.2.2. Scanning the File

Now we’ll scan either the plain text file you just produced, or the sample one included with this 
document.

Start the Word Hider program if you haven’t.  (Quit from the Word Processor if you need to, to 
free up memory - you’re through with it.)   Now select Import Words from Text File from 
the File menu, like this:
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You’ll get a window like this:

This window presents you with a number of options.  Normally, you can just accept them and 
click the Import button (or press Return).  If you need to modify the behaviour of the scan 
function, the options are as follows:

How Much of File? Normally set to Whole File.  If you want to read only some of the
lines in the file, select Only Lines and enter the line numbers of 
interest in the two numeric fields.  (You can’t type in these fields 
unless the Only Lines option is selected.)

Ignore Words Length The program normally ignores any words less than or equal to 3 
characters in length, since these are rather uninteresting in a 
puzzle.  You can change the length to some other number by 
clicking and typing over the “3”, or turn this feature off entirely by 
clicking to turn off the “X” in the check box.
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Ignore Words Containing… If this box is checked, words containing characters other than 

letters will be ignored.  I’ve found this helps to eliminate some 
technical acronyms and other unwanted items the program might 
otherwise mistake for words.  Turn this 
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option off if you want anything in the text file to be allowed in the puzzle.

Translate to Uppercase Normally on, as you normally want all words in the vocabulary to 
be in upper case.

Automatically Ignore… Words that are subsets of existing words will be ignored, speeding 
up the scan.  (As described above in the “Pseudoword Conflicts” 
section, they will be rejected later anyway.)  You might turn this 
off, allowing all words in, so that you can control which conflicting
words are eliminated.

Normally, you will accept the suggested settings for all of these options, and just press 
“Import”.  The program will then ask you to identify the file to be scanned.  Use the standard 
Mac file dialog to lead it to the plain text file you have created:

After you click Open the text file will be scanned.  This can take several minutes for a large file.
Then you will be given an opportunity to inspect the results, as described in the next section.
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2.1.2.3. Fine-Tuning the Results

After a text file has been scanned, and if any words were found, you are presented with a 
window listing the words found, like this:

You can use this window to make minor adjustments to the set of words (i.e. eliminating any you
don’t like), and then can pass them on to the Main Word List.  The following functions are 
available in this window:

• You can click on words in the list and move them up or down, to assist with your 
organization.  Position in the list has no other effect.

• The buttons Sort and Length sort the words in the list alphabetically or by length, 
respectively.  This is only to assist your inspection of the list and has no other effect.

• After clicking to highlight one or more words, you can click Remove to remove them 
from the list of words to be imported.
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• Click Cancel to abandon this entire import process, or Import to send the words to the 

Main Word List.
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2.2. Laying Out the Printed Page

In the example early in this manual, you used the Layout Window to define how the components 
of the puzzle (grid and word list) should appear on the printed page.  In this section we look at 
these layout facilities in more detail.

2.2.1. Layout Objects

Most of the layout tasks are performed by defining and editing layout objects on the layout 
window.  The available layout objects are displayed in the column at the left of the layout 
window:

"arrow tool"

scale factor

full scale

reduced scale

layout objects

The important items in the left part of the layout window are:

Arrow Tool Used to point at objects drawn in the layout, prior to dragging, resizing, 
font setting, or performing other operations on them.

Layout Objects Used to draw where on the page various components of the puzzle (e.g. 
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the puzzle grid, the word list) will appear.

Scale Factor Tells you whether you are looking at the page layout in actual size, or as a 
reduced view.

Full Scale Returns you to actual size view if you are in a reduced view.
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Reduced Scale Shrinks the contents of the window enough for you to see a representation 
of the entire printed page, so you can lay things out according to their 
position on the sheet of paper you will produce.

2.2.2. Reduced Views

To enable you to lay out where puzzle components will appear in relation to the sheet of paper 
you will eventually produce, you can view a reduced scale representation of the entire page, 
shrunk to fit in the window space.  For example, when the program is first started, the layout area
looks like this:

You have visible only about 3 - by - 4 inches of the printed page, and scroll bars to allow you to 
see the rest of it.  
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Select the Puzzle Area tool and click-drag to draw a puzzle rectangle, as in the example in 
section one.  Something like this:

(The number of rows and columns in your grid may be different, and that doesn’t matter.)

You are looking at the puzzle grid in actual size - it will be exactly this size on the printed page.  
However, it’s difficult to visualize how the entire page will look when viewed only a piece at a 
time.  If you click the “reduced scale” button (which is supposed to be a mountain range seen 
from a distance!): 

the window will redraw as follows:
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Note the “39%” in the scale factor area.  On your Mac, a different scale factor may appear, 
depending on your screen and window size.  The upright rectangle is a representation of the 
entire printed page.  The puzzle grid has been reduced in apparent size so you can see where it 
will be on the printed page.

All the operations described below:  defining layout objects, moving them around, and 
changing their shape or size, may be performed in the actual size or reduced size views - 
whatever is most convenient for you.

2.2.3. Selection, dragging, resizing

If you have the Arrow Tool selected and click the mouse button once on a layout object, it will 
become highlighted with a dark boundary, as the puzzle grid in the example above is.  You may 
perform a number of operations on a layout object selected in this way:

• Once selected, you can press the Delete keyboard key to delete the layout object from the 
view.
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• By holding the mouse button down over a layout object, you can drag it around on the 

view, changing its position on the printed page.

• By carefully clicking and holding on the small dot in the lower left corner of a layout 
object:
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you can drag that corner to a new position, thus changing the size and shape of the object.

• If you double-click on any layout object, you will be given a window in which to modify 
certain options of that object.  These options are described later in this document.

2.2.4. Font Selection

When a layout object is highlighted, you may select items from the Font and Size menus to 
change to font of the text contained in that object.

2.3. The Puzzle Grid

The puzzle grid, drawn on the layout window, is probably the object you will interact with most.

2.3.1. Rows and Columns

The grid consists of rows and columns, forming a number of “cells”, each of which contains one 
of the puzzle letters.  

If you have defined the word list before the puzzle grid is drawn, the program will automatically 
estimate a suitable number of rows and columns.  However, you can change these dimensions at 
any time, as described in “Grid Options” below.  Factors affecting the number of rows and 
columns include:

• The number of cells (rows x columns) must be sufficient to hold the total number of letters 
in the words in the word list.

• There must be room for the longest words in the word list - normally this means that either 
or both of the number of rows and the number of columns must be at least the length of the 
longest words.

• As much as possible under the above criteria, the puzzle should be nearly square, for 
esthetic reasons.
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2.3.2. Grid Options

If you double-click on the puzzle grid drawn in the layout window, a window for modifying 
certain options opens, like this:
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After you click Ok the puzzle grid will be modified according to any changes you have made.  
The options are:

Rows & Columns The dimensions of the puzzle.  You can change these numbers to make the 
puzzle larger or smaller.  If you make the puzzle smaller, and have already 
defined words, you may make it impossible to fit all the words in the 
puzzle.  If you make the puzzle smaller, and have already placed words in 
the grid, words may have to be unplaced, and you will be informed of this 
situation.

Upper Case If this option is on, the puzzle letters will be displayed in upper case 
regardless of whether the words in the word list are in upper or lower case.

Snap Frame If this option is on, the height and width of the puzzle grid will be 
constrained to multiples of the cell size, so you can never end up with a 
row or column partially cut off at the boundaries of the grid.  (On the other
hand, it makes resizing the grid a bit more difficult since resizing will 
“round” to an appropriate size, instead of responding exactly to the 
changes you make with the mouse.)

Display Frame If on, a box is drawn around the puzzle grid.

Display Grid If on, dotted lines are drawn between the cells in the puzzle grid.
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2.3.3. Automatic Font Size

You can set the font and font size of any of the layout objects using the Font and Size menus in 
the normal manner.  However, for the puzzle grid only, there is another font sizing option, Fit to 
Cell, you’ll normally use:
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This option may be chosen only while the puzzle grid layout object is selected.  When it is 
selected (indicated by the check mark) the font size of the puzzle letters will be automatically 
calculated to fit into the puzzle cells.  If the puzzle grid is resized, the font size will be adjusted 
automatically.

2.3.4. Placement Options

There are a number of options that control how the program places words into the puzzle grid.  
These options are accessed from the Options… item in the Puzzle menu.

Selecting the Options… item opens an options window like this:
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Allowed 
Directions

Search 
Method

The options are as follows:

Search Method This area controls how the program attempts to fit words into the puzzle.  
Some methods are faster, while others are slow but find do a more 
complete job.  The methods are described in detail in the “Search and 
Placement Methods” section later in this document.

Allowed Directions These arrows indicate the directions in which you are willing to allow 
words in the puzzle grid to run.  Normally, you would allow only the 
“normal” English directions of left-to-right, top-to-bottom, and perhaps 
the equivalent diagonals.  However, you can also allow the reverse 
directions, by clicking the appropriate boxes, to make a more difficult 
puzzle.
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The All and None buttons quickly turn all the directions on or off.  Note 
that you can’t close this window with all the directions off - you must 
permit at least one direction.

Show Progress If this option is enabled, you get information messages as the program 
searches for positions for your words.
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Keep Cells Square This option constrains the puzzle grid size, when resizing, to sizes that 
allow the individual cells to remain perfect squares.

2.4. Printing Word List

In most circumstances you want the list of words being sought to appear on the page with the 
puzzle.  You’ve seen the use of the Word List tool to define the basic word list area:

If you use the Arrow tool to double-click on the word list that results, you get an options window
like this:
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The options are as follows:

Columns Can be used to select the number of columns the words will be arranged 
into in the list area.

Blank Line The words are sorted alphabetically.  If this option is selected, blank line 
will separate the words beginning with subsequent letters of the alphabet.

Frame If selected, a rectangle is drawn around the word list area.

Grid If selected, dotted lines will separate the words in the word list.

Upper Case If selected, all the words in the word list area will be displayed in upper 
case, regardless of how they are entered in the Main Word List.

2.5. Filling Unused Cells

Since the number of letters in the words in the Main Word List will rarely be exactly enough to 
fill the cells of the puzzle grid, you have two options for filling in the remaining cells.

Both of the following options, Random and Specified fill should be used only after you have 
finished placing words into the puzzle.  Also, the fill must be removed before any changes can be
made to the placement of words in the puzzle.

1.0 February, 1996 ©1996 Page 75



1.0 February, 1996 ©1996 Page 76

2.5.1. Random Fill

If you would like to fill unused cells with random characters, select Random Fill… from the 
Puzzle menu:
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This will generate a control window like this:

The control set allows you to specify whether the fill is uppercase, lowercase, or a mixture.  Or, 
if you wish, you can restrict the fill to random characters drawn from a list you provide.  
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For example, if you wanted all the unused cells filled with only Vowels, you could select the 
following:

When you click Ok the unused puzzle grid cells will be filled in to your specifications.
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2.5.2. Specified Fill

In more advanced puzzles, it is common to put a “hidden message” in the unused puzzle cells.  
To do this, select the Specified Fill… item from the Puzzle menu, like this:
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This will present you with the following control window:

You should type the message you want placed in the unused cells into the text area in this 
window.  The window will tell you how many unused cells you have available, but you are 
responsible for ensuring that your message is of the correct length.

Normally, your message may consist of several words (e.g. “the hidden message”) but you want 
only the letters (i.e. not the spaces) put in the puzzle grid.  Checking Use only letters from 
above text allows you to type the spaces while getting only the letters.  If you select Use ALL
characters in above text then every character you type, including spaces and punctuation, 
will be copied into the puzzle grid.

The characters will be copied into the puzzle grid in the same order you type them.  If you want a
harder puzzle, select the Anagram option, and the letters will be shuffled before placing into 
the grid.
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You’ll be warned if you click Ok with a message length that does not fit the available unused 
cells.  Turn off the Warn size misfit option to skip this warning.
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2.5.3. Printing Fill-In-Blanks Answer Area

If you have used Specified Fill to put a hidden message in the unused puzzle cells, you can draw 
a “fill-in-the-blanks” area on the page to help the user copy the answer.  (This is normally a set of
boxes or underscores, one for each letter, possibly with appropriate spaces and punctuation 
provided.)

Draw the Answer Area on the layout window using the Answer Area tool, in the usual manner:

As you saw in the example, the program will normally put boxes and shading in the answer area 
in a way that corresponds to the hidden text you typed.  If you want to modify this processing,  
double-click on the resulting rectangle to get the following options window:
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Clicking Automatic Setup generates the standard boxes tailored to your hidden message.  For
any other processing, you must type a code string into the text area indicating how you would 
like blank cells and punctuation organized.  The details of the code string are specified below.

Every character in the code string defines a position in the Answer Area on the printed page.  The
characters have the following meanings:

^ or blank Every blank or “^” character will generate a blank place in the answer area
for the user to copy a letter.  The blank area will be surrounded by a box, 
or only underlined, depending on the relevant radio button setting.

~ Every tilde symbol will generate a shaded cell on the answer area.  These 
are used to tell the user where the separation between words lies.

others Any other character will be copied to the answer area, thus allowing 
punctuation to be present.
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When you click the Automatic Setup button (or if you do nothing), a suitable string is 
generated as follows:
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• The length is the same as the length of the message in the Specified Fill window.

• Every letter in the Specified Fill window will generate a blank space in the answer area 
(room for the user to copy that letter in).

• Every space in the Specified Fill window will generate a shaded cell in the answer area.

• Every other character in the Specified Fill window will be copied to the answer area.

Here are some examples of answer area settings and the answer area they generate:

Suppose the hidden message is “See Dick Run”, with just the letters “SEEDICKRUN” copied 
into the puzzle grid.

generates:
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Next, suppose we want the user to find the letters “PARISSPRING” and generate the hidden 
message “Paris in the spring.”.  Note that we have not hidden the words “in the” in the puzzle - 
we will be supplying these.  The following window:

will generate the answer area:

2.6. Other Layout Items

You can further decorate the puzzle page by typing in arbitrary text blocks, and by pasting in 
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pictures copied from other applications.

2.6.1. Text fields

To type arbitrary text (such as titles) on the page, use the Other Text tool to draw the text area 
in the normal manner:
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Immediately after you draw the area to contain the text, you can type any text you wish.  You can
use all the normal text editing features of the Mac here - selecting text with the mouse, changing 
font, etc.  Click the mouse outside the text area to end text entry.
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2.6.2. Pasted-in pictures

If you have a clip-art library or create your own pictures using some other application (e.g. 
MacDraw) you can Copy a picture from that application and then Paste it into your puzzle 
layout.  It will be placed in a standard position in the window, and you can then move or resize it.

To move or resize a pasted-in picture, use the Arrow tool to drag or resize it in the normal 
manner.  For example, click on the following picture (right here, in this document), then do a 
Copy from the word processor’s Edit menu:

   

Now enter the Word Hider program, bring the Layout Window to the front, and select Paste 
from the Edit menu:
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The picture will be pasted into the layout area as follows:

You can use the Arrow tool to move this picture to a desired location, or to reshape or resize it by
clicking on the handle in the lower-right corner, just like any other puzzle layout object.

Note, however, that using the mouse on the corner handle isn’t a very good way to resize a 
picture, since if you don’t move the corner in the proper proportion, the picture will be distorted. 
For example:
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A better way to resize pictures is to double-click and get the following options window:
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You can select one of the rescaling options to change the size in correct proportions.
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3. Search and Placement Methods

The most important, and often the most difficult, task you have is placing the words from the 
puzzle vocabulary into the puzzle grid.  If you have relatively few words for the grid size, this is 
easy and the automated placement will work well.  If you have a lot of words, and are hoping to 
have very few leftover cells, automated placement is difficult and can be time consuming;  so the
program has a number of methods available and you may need to experiment.

Also, if you want a mixture of horizontal and diagonal placement of words, and the puzzle is 
very full, you may find that the optimized search algorithms avoid using diagonal placements 
(since diagonal placements reduce the number of remaining positions available for words).

You can also manually place words into the puzzle, remove them from the puzzle, or make minor
adjustments to their placement.

For a very full puzzle, you will often need to use a mixture of automatic and manual techniques, 
possibly including different automatic search methods.  The various options are documented 
below, and you can experiment to determine what suits you best.

3.1. Search Algorithms

The automated search performed when you click the Auto Place button, or select  Autoplace
Words from the Puzzle menu, can use several different search techniques.  To choose one, you 
use the Options… menu from the Puzzle menu, getting the following window:
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You’ve seen this window before.  The search methods are selected by the buttons on the right.  
They are:

First Fit The default method.  It is very fast, and just randomly selects the first 
position for each word that fits.  It’s fine for a puzzle that’s not too 
full.  Because the choices are random, the various placement 
directions you allow (including diagonals) will be evenly used.

A typical 10 x 10 puzzle will be processed in a minute or so with this 
option.

For a very full puzzle, it’s not very good because the random 
selections will spoil a lot of the remaining free space by placing 
words across openings, reducing the size of remaining openings for 
remaining words.

Maximize Slack This is a “middle of the road” search method.  It is slower than First 
Fit but faster than “Score Every Location”, and will find positions for 
more of your words.  It works by assigning each word to a position 
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that maximizes the size of the remaining portion of the row, column, 
or diagonal to which the word is assigned.  Thus, it tends to maximize
the amount of free space remaining in the puzzle as placement 
proceeds.

A typical puzzle will be processed in several minutes with this option.
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Because diagonals tend to mess up free space, this algorithm won’t 
choose them very often, although it doesn’t deliberately avoid them.

Score Every Location This is a “brute force” search, producing the best results but taking a 
very long time.  For a large puzzle you might need to let this method 
run for several hours.

For every word, it evaluates every possible placement, picking the 
best according to a number of criteria including maximizing 
remaining space, avoiding cutting off other open spaces, etc.

It also tends to avoid diagonals since they tend to be less optimal.

3.2. Manual Placement 

You can also manually place (or unplace) words in the puzzle.

You can only do this if the “fill characters” have not been inserted.  In the examples 
below, make sure you do not put the “fill” in, or remove it with the “Remove Fill” menu 
item.

To learn how to use the manual placement facility, and to make sure that your system will work 
the same as mine in the following examples, do the following:

• Start up a new, empty puzzle.

• Put the words “learning”, “how”, “manual”, “placement”, “ability”, “works” into the 
vocabulary.

• Define a puzzle grid.  The program should automatically select a 9 x 5 grid unless you have
changed the layout options.  If you don’t get a 9 x 5 grid, double-click on it and set it to 9 
rows and 5 columns.

• Select Options… from the Puzzle menu and make sure the Allowed Directions are as 
follows:
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• Find the option key on your keyboard - you’ll need it.

3.2.1. Manually Placing Words

While holding down the option key, use the arrow tool to click on the free cell in the top left 
corner of the puzzle grid, and hold the mouse button down for a moment.

After a moment, a “pop up menu” will appear like this:
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If this doesn’t happen, make sure your are holding down the option key.

The program is showing you all the words that can be placed, starting at that puzzle cell, and 
using the allowed directions you defined.  Move down until “ability” is highlighted, then release 
the mouse:

When you release the mouse button, the word will be placed at the selected location:
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Now let’s try placing a word in a location where it would fit in more than one direction.  Option-
click-hold on the cell at row 2, column 2, and then select the word “how” from the pop-up menu.

The program will notice that the word fits in more than one direction, and asks you which 
direction you want to use, with the following window:
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The highlighted arrows are the available directions.  For this example, click on the down-right 
pointing diagonal arrow:
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The program will place the word according to your instructions.

3.2.2. Manually UnPlacing Words

The unplace a word (remove it from the grid, but not from the vocabulary), option-click-hold on 
any character of the word in the puzzle grid.  For example, option-click-hold on the “B” in the 
word “ABILITY” in the grid:

A Pop-up menu will appear like this:
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Select “Unplace” and release the mouse button.  (Ignore the “slide right” option for now).  The 
word will be removed from the grid and put back in the Unplaced List in the vocabulary 
window:

Keep your example handy and proceed to the next section.

3.3. Placement Adjustment

You can make minor changes to the placement of words using a similar technique.  From the 
example above, now option-click-hold on one of the characters in the word “HOW”:

The pop-up menu will look like this:
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Ignore the Unplace option this time.  The other options are the program pointing out directions 
that this word could move from its present position to “take up the slack” in its current 
placement.  Select “Slide up & left” and the program will move the word up and left like this:

3.4. Recommended Approaches

If your puzzle is not very full (i.e. you have lots of unused cells) you should be able to use the 
“First Fit” search and get good results.  If one or two words are left unplaced, you can use the 
manual placement adjust options (slide, unplace, and place) to make minor adjustments, and you 
should be able to fit them all in.  (Don’t forget the option of just deleting words that don’t fit.)

If the puzzle is quite full, you’ll need to use one of the slower search algorithms, and then might 
still need to do some manual adjustment to fit the last word or two in.

Remember that you can use more than one search.  To ensure that some diagonals get used, you 
could set up Options allowing only diagonals, place a few words, then change the Options to 
allow non-diagonals and place the rest.  Or, manually place one or two diagonals first, then run 
an automatic placement for the rest of the words.

By the way, you can interrupt the placement search by holding down the command and period 
keys at the same time.  (i.e. pressing ⌘. at the same time, and holding them until the search stops
- it may take a few seconds to notice you.)
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4. Menu Reference

4.1. Menus

4.1.1. File menu

The File menu items are:

New Creates a new, empty, puzzle file.  Since you can only have one open at a 
time, this item is disabled if there is already a puzzle open.

Open… Opens a puzzle file saved with the Save or Save As items below.  Since 
you can only have one open at a time, this item is disabled if there is 
already a puzzle open.

Close Closes the open puzzle file, allowing you to use New or Open again.
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Save See Save As… below, except that the file’s current name is used instead 

of asking you for a name.
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Save As… This allows you to save your puzzle definition in a document file.  The 
vocabulary, layout details, etc., are all saved, so you can reopen and 
continue work on the puzzle later.

Import… This option brings up the window that allows you to scan a plain text file 
and import from it the words meeting specified criteria.

Export… This option is not implemented yet.  It will eventually allow you to write 
your vocabulary to a file, to import it into other programs.

Page Setup… The standard printer setup command.

Print… The standard print command.  It is always the page represented by the 
Layout Window that is printed.

Preferences… This gives access to a window where you can set certain defaults for the 
program.  Unlike the other options settings in the program, options set via 
the Preferences item are permanent - they will continue to apply to all 
further uses of the program, even after the computer is shut down.

Memory… There are suboptions of this menu intended to help debug low-memory 
situations.  You normally don’t need to use it.

Quit

4.1.2. Edit menu

This is the standard Mac Edit menu.  The various options will be enabled when they make sense 
- generally when there is text or a layout object to copy or paste.
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4.1.3. Font menu

When a layout object is selected, this menu will set its font.  The current font is shown with a 
check mark.  If no layout object is selected, then this sets the default font that will be assigned to 
the next layout object created.

4.1.4. Size menu

When a layout object is selected, this menu will set its font size.  The current font size is shown 
with a check mark.  If no layout object is selected, then this sets the default font size that will be 
assigned to the next layout object created.  The special Fit to Cell item works only with the 
puzzle grid, and is described above in this document.
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4.1.5. Puzzle menu

The items are as follows:

Word List Window Brings the Main Word List window to the front.

Layout Window Brings the Layout window to the front.

AutoPlace Words Uses the chosen Placement Algorithm to attempt to automatically 
place any unplaced words into the puzzle grid.

Random Fill… Allows you to fill the remaining unused puzzle grid cells with 
characters selected at random from a given set.

Specified Fill… Allows you to fill the remaining unused puzzle grid cells with 
characters you specify - normally a “hidden message” to be found 
by the user.

Remove Fill Removes from the grid any fill characters put there by Random 
Fill or Specified Fill.

Options… Gives access to options on how placement is performed.

Tutorial Mode… Ensures that the examples in chapter 1 of this document produce 
exactly the results in the document when you run the examples.
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5. Troubleshooting

5.1. Memory

The WordHider program normally needs 2 or 3 Megabytes of RAM to run.  If you need to adjust 
this number, you use the Finder as follows:

• If the WordHider program is running, quit out of it.

• Find the actual program file, with the  icon.  Click once on it so that it highlights.

• Select the Get Info item from the File menu:
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In the window that appears:

You can increase the memory allocated to the program by increasing the number beside 
“Preferred size”.  3000 is 3 Megabytes, the normal value.

5.2. Known Problems

• The program does not handle 1-letter words properly.  (Frankly, it never occurred to me 
that anyone would use one-character words, because that would rule out the use of any 
other word containing that character.)  I’ll try to get it working in a future version.
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